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Introduction

Welcome to PowerPoint 2016 For Dummies, the book
written especially for people who are lucky enough to
use this latest and greatest version of PowerPoint and
want to find out just enough to finish that presentation
that was due yesterday.

Do you ever find yourself in front of an audience, no
matter how small, flipping through flip charts or
shuffling through a stack of handwritten transparencies?
You need PowerPoint! Have you always wanted to take
your notebook computer with you to impress a client at
lunch, but you haven’t known what to do with it between
trips to the salad bar? You really need PowerPoint!

Or maybe you're one of those unfortunate folks who
bought Microsoft Office because it was such a bargain
and you needed a Windows word processor and
spreadsheet anyway, and hey, you're not even sure what
PowerPoint is, but it came with the software you
purchased, so it didn’t cost extra. Who can resist a
bargain like that?

Whichever circumstance you find yourself in, you're
holding the perfect book right here in your formerly
magic-marker-stained hands. Help is here, within these
humble pages.

This book talks about PowerPoint in everyday — and
often irreverent — terms. No lofty prose here; the whole
thing checks in at about the fifth-grade reading level. I
have no Pulitzer expectations for this book. My goal is to
make an otherwise dull and lifeless subject at least
tolerable, and maybe even kind of fun.



About This Book

This isn’t the kind of book that you pick up and read from
start to finish as though it were a cheap novel. If I ever
see you reading it at the beach, I'll kick sand in your
face. This book is more like a reference — the kind of
book you can pick up, turn to just about any page, and
start reading. It has 22 chapters, each one covering a
specific aspect of using PowerPoint — such as printing,
animating your slides, or using clip art.

You don’t have to memorize anything in this book. It’s a
need-to-know book: You pick it up when you need to
know something. Need to know how to create an
organization chart? Pick up the book. Need to know how
to override the Slide Master? Pick up the book. After you
find what you're looking for, put it down and get on with
your life.

I use a few conventions to communicate information:

1~ Keyboard shortcuts: On occasion, this book directs
you to use specific keyboard shortcuts to get things
done. When you see something like Ctrl+Z, this
instruction means to hold down the Ctrl key while
pressing the Z key and then release both together.
Don’t type the plus sign.

1 Commands: Sometimes | tell you to use a command
that resides on the new Ribbon interface like this:
Choose Home = Editing = Find. That means to click the
Find button, which you can find in the Editing group on
the Home tab.

1 Onscreen messages: Whenever | describe a
message or information that you see onscreen, it looks
like this:

Are we having fun yet?



1 Buttons in the margin: Whenever | discuss a certain
button that you need to click in order to accomplish
the task at hand, the button appears either in the
margin or in a helpful table that summarizes the
buttons that apply to a particular task. This way, you
can easily locate it on your screen.

1~ Bold text: Type bold text just as it appears in the
book. The exception is when you’re working through a
steps list: Because each step is bold, the text to type is
not bold.

1 Monofont: Web addresses and programming code
appear in monofont. If you're reading a digital version
of this book on a device connected to the Internet, you
can click the web address to visit that website, like
this: www.dummies. com.

Foolish Assumptions

I make only three assumptions about you:

» You use a computer.

1 It's a Windows computer — not a Mac. (PowerPoint
2016 requires at least Windows 7.)

1 You use or are thinking about using PowerPoint 2016.

Nothing else. I don’t assume that you’re a computer guru
who knows how to change a controller card or configure
memory for optimal use. These types of computer chores
are best handled by people who like computers. My hope
is that you're on speaking terms with such a person. Do
your best to stay there.

Icons Used in This Book
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As you're reading all this wonderful prose, you
occasionally see the following icons. They appear in the
margins to draw your attention to important information.
They’re defined as follows:
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Watch out! Some technical drivel is just around
the corner. Read it only if you have your pocket
protector firmly attached.

R

@ Pay special attention to this icon — it tells you that
some particularly useful tidbit is at hand, perhaps a
shortcut or a way of using a command that you might
not have considered.
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‘/ Danger! Danger! Danger! Stand back, Will
Robinson!
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“H Did I tell you about the memory course I took?
Paragraphs marked with this icon simply point out
details that are worth committing to memory.

Beyond the Book

I couldn’t fit everything about PowerPoint 2016 in these
pages, so you can go online to find even more
information:

1~ Cheat Sheet: Go to
www.dummies . com/cheatsheet/powerpoint2016 to find a
variety of shortcuts for everything from formatting and
editing to slide shows and more.
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1 Web Extras: Go to
www.dummies.com/extras/powerpoint2016 to access articles
on how to add recurring text, how to create a hyperlink
to another slide, how to add comments to
presentations, and more.

Where to Go from Here

Yes, you can get there from here. With this book in hand,
you're ready to charge full speed ahead into the strange
and wonderful world of desktop presentations. Browse
through the table of contents and decide where you want

to start. Be bold! Be courageous! Be adventurous! Above
all else, have fun!
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In this part ...

1 Get a bird’s-eye view of PowerPoint 2016 and what you
can do with it.

1 Find out how to edit the content on PowerPoint slides,
from the text itself to text objects to other types of
objects, such as clip art pictures or drawn shapes.

1 Understand how to work in Outline View so you can
focus on your presentation’s main points and subpoints
without worrying about appearance.

1 Learn to proof your presentation with PowerPoint and
avoid embarrassing mistakes.

1 Discover how to create speaker notes to help you get
through your presentation.

1 Know how to finish the final preparations by printing
copies of your slides, notes, and handouts, as well as
how to set up a projector and actually deliver your
presentation.



Chapter 1
Welcome to PowerPoint

In This Chapter

Discovering PowerPoint

Firing up PowerPoint

Making sense of the PowerPoint screen and the
Ribbon

Visiting backstage

Creating a presentation

Viewing presentation outlines

Saving and closing your work

Retrieving a presentation from the hard drive

Getting help

Getting out of PowerPoint

This chapter is a grand and gala welcoming ceremony
for PowerPoint 2016, Microsoft’s popular slide-
presentation program.

This chapter is sort of like the opening ceremony of the
Olympics, in which all the athletes parade around the
stadium and people make speeches in French. In much
the same way, this chapter marches PowerPoint 2016
around the stadium so you can get a bird’s-eye view of
what the program is and what you can do with it. I might
make a few speeches, but not in French (unless, of
course, you're reading the French edition of this book).
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What in Sam Hill Is
PowerPoint?

PowerPoint is a program that comes with Microsoft
Office (although you can buy it separately, as well). Most
people buy Microsoft Office because it’s a great bargain:
You get Word, Excel, and Outlook all together in one
inexpensive package. And PowerPoint is thrown in for
good measure. Of course, depending on which edition of
Office you buy, you might get other goodies as well, such
as Access, Publisher, a complete set of Ginsu knives, and
a Binford VegaPneumatic Power Slicer and Dicer.
(Always wear eye protection.)

You know what Word is — it’s the world’s most loved and
most hated word processor, and it’s perfect for
concocting letters, term papers, and great American
novels. I'm thinking of writing one as soon as I finish this
book. Excel is a spreadsheet program used by bean



counters the world over. Outlook is that program you use
to read your email. But what the heck is PowerPoint?
Does anybody know or care? (And as long as I'm asking
questions, who in Sam Hill was Sam Hill?)

PowerPoint is a presentation program, and it’s one of the
coolest programs I know. It’s designed to work with a
projector to display presentations that will bedazzle your
audience members and instantly sway them to your point
of view, even if you're selling real estate on Mars, season
tickets for the Oakland Raiders, or a new tax increase to
a congressman in an election year. If you've ever flipped
a flip chart, you’'re going to love PowerPoint.

Here are some of the many uses of PowerPoint:

1~ Business presentations: PowerPoint is a great
timesaver for anyone who makes business
presentations, whether you’ve been asked to speak in
front of hundreds of people at a shareholders’
convention, a group of sales reps at a sales
conference, or your own staff or co-workers at a
business meeting.

1~ Sales presentations: If you're an insurance
salesperson, you can use PowerPoint to create a
presentation about the perils of not owning life
insurance and then use your laptop or tablet computer
to show it to hapless clients.

1~ Lectures: PowerPoint is useful for teachers or
conference speakers who want to reinforce the key
points in their lectures with slides.

1 Homework: PowerPoint is a great program to use for
certain types of homework projects, such as those big
history reports that count for half your grade.

1 Church: People use PowerPoint at churches to display
song lyrics on big screens so everyone can sing or to



display sermon outlines so everyone can take notes. If
your church still uses hymnals or prints the outline in
the bulletin, tell the minister to join the 21st century.

1 Information stations: You can use PowerPoint to set
up a computerized information kiosk that people can
walk up to and use. For example, you can create a
museum exhibit about the history of your town or set
up a tradeshow presentation to provide information
about your company and products.

1~ Internet presentations: PowerPoint can even help
you to set up a presentation that you can broadcast
over the Internet so people can join in on the fun
without having to leave the comfort of their own
homes or offices.

Introducing PowerPoint
Presentations

PowerPoint is similar to a word processor such as Word,
except that it’s geared toward creating presentations
rather than documents. A presentation is kind of like
those Kodak Carousel slide trays that your grandpa filled
up with 35mm slides of the time he took the family to the
Grand Canyon in 1965. The main difference is that with
PowerPoint, you don’t have to worry about dumping all
the slides out of the tray and figuring out how to get
them back into the right order.

Word documents consist of one or more pages, and
PowerPoint presentations consist of one or more slides.
Each slide can contain text, graphics, animations, videos,
and other information. You can easily rearrange the
slides in a presentation, delete slides that you don’t



need, add new slides, or modify the contents of existing
slides.

You can use PowerPoint both to create your
presentations and to actually present them.

You can use several different types of media to actually
show your presentations:

1 Computer screen: Your computer screen is a suitable
way to display your presentation when you're showing
it to just one or two other people.

1~ Big-screen TV: If you have a big-screen TV that can
accommodate computer input, it’'s ideal for showing
presentations to medium-sized audiences — say 10 to
12 people in a small conference room.

1 Computer projector: A computer projector projects
an image of your computer monitor onto a screen so
large audiences can view it.

1 Webcast: You can show your presentation over the
Internet. That way, your audience doesn’t all have to
be in the same place at the same time. Anyone with a
web browser can sit in on your presentation.

1~ Printed pages: Printed pages enable you to distribute
a printed copy of your entire presentation to each
member of your audience. (When you print your
presentation, you can print one slide per page, or you
can print several slides on each page to save paper.)

1 Overhead transparencies: Overhead transparencies
can be used to show your presentation using an
overhead projector. It's a little old-school to be sure,
but some people still do it this way.

Your presentations will be much more interesting if you
show them using one of the first four methods (computer



monitor, TV, projector, or webcast) because you can
incorporate animations, videos, sounds, and other whiz-
bang features in your presentation. Printed pages,
overheads, and 35mm slides can show only static
content.

Presentation files

A presentation is to PowerPoint what a document is to
Word or a worksheet is to Excel. In other words, a
presentation is a file that you create with PowerPoint.
Each presentation that you create is saved on your
computer’s hard drive as a separate file.

PowerPoint 2016 presentations have the special
extension .pptx added to the end of their filenames. For
example, Sales Conference.pptx and History
Day.pptx are both valid PowerPoint filenames. When you
type the filename for a new PowerPoint file, you don’t
have to type the .pptx extension, because PowerPoint
automatically adds the extension for you. Windows may
hide the .pptx extension, in which case a presentation
file named Conference.pptx often appears as just
Conference.

W

I recommend you avoid the use of spaces and
special characters, especially percent signs (%), in
your filenames. If you want the effect of a space in a
filename, use an underscore character instead.
Spaces and percent signs in filenames can cause all
kinds of problems if you post your presentation files
to the Internet, either on a web page or even as a
File Transfer Protocol (FTP) upload.



Versions of PowerPoint prior to 2007 save
presentations with the extension .ppt instead of
.pptx. The x at the end of the newer file extension
denotes that the new file format is based on an open
XML standard data format that makes it easier to
exchange files among different programs.
PowerPoint 2016 can still save files in the old . ppt
format, but I recommend you do so only if you need
to share presentations with people who haven't yet
upgraded to PowerPoint 2007 or later.

PowerPoint is set up initially to save your presentation
files in the Documents folder, but you can store
PowerPoint files in any folder of your choice on your hard
drive or on any other drive. You can also save your
presentation to online file storage, such as Microsoft’s
OneDrive. And, if you wish, you can write a presentation
to a USB flash drive or to cloud storage.

What’s in a slide?

PowerPoint presentations comprise one or more slides.
Each slide can contain text, graphics, and other
elements. A number of PowerPoint features work
together to help you easily format attractive slides:

1~ Slide layouts: Every slide has a slide layout that
controls how information is arranged on the slide. A
slide layout is simply a collection of one or more
placeholders, which set aside an area of the slide to
hold information. Depending on the layout that you
choose for a slide, the placeholders can hold text,
graphics, clip art, sound or video files, tables, charts,
graphs, diagrams, or other types of content.



1~ Background: Every slide has a background, which
provides a backdrop for the slide’s content. The
background can be a solid color; a blend of two colors;
a subtle texture, such as marble or parchment; a
pattern, such as diagonal lines, bricks, or tiles; or an
image file. Each slide can have a different background,
but you usually want to use the same background for
every slide in your presentation to provide a consistent
look.

1 Themes: Themes are combinations of design
elements such as color schemes and fonts that make it
easy to create attractive slides that don’t look
ridiculous. You can stray from the themes if you want,
but you should do so only if you have a better eye
than the design gurus who work for Microsoft.

1~ Slide Masters: Slide Masters are special slides that
control the basic design and formatting options for
slides in your presentation. Slide Masters are closely
related to layouts — in fact, each layout has its own
Slide Master that determines the position and size of
basic title and text placeholders; the background and
color scheme used for the presentation; and font
settings, such as typefaces, colors, and sizes. In
addition, Slide Masters can contain graphic and text
objects that you want to appear on every slide.

You can edit the Slide Masters to change the
appearance of all the slides in your presentation at
once. This helps to ensure that the slides have a
consistent appearance.

All the features described in the preceding list work
together to control the appearance of your slides in
much the same way that style sheets and templates
control the appearance of Word documents. You can



customize the appearance of individual slides by adding
any of the following elements:

1~ Title and body text: Most slide layouts include
placeholders for title and body text. You can type any
text that you want into these placeholders. By default,
PowerPoint formats the text according to the Slide
Master, but you can easily override this formatting to
use any font, size, styles like bold or italic, or text color
that you want.

1~ Text boxes: You can add text anywhere on a slide by
drawing a text box and then typing text. Text boxes
enable you to add text that doesn’t fit conveniently in
the title or body text placeholders.

1 Shapes: You can use PowerPoint’s drawing tools to
add a variety of shapes to your slides. You can use
predefined AutoShapes, such as rectangles, circles,
stars, arrows, and flowchart symbols. Alternatively,
you can create your own shapes by using basic line,
polygon, and freehand drawing tools.

» lllustrations: You can illustrate your slides by
inserting clip art, photographs, and other graphic
elements. PowerPoint comes with a large collection of
clip art pictures you can use, and Microsoft provides an
even larger collection of clip art images online. And, of
course, you can insert photographs from your own
picture library.

1 Charts and diagrams: PowerPoint includes a slick
diagramming feature called SmartArt that enables you
to create several common types of diagrams, including
organization charts, cycle diagrams, and others. In
addition, you can insert pie charts, line or bar charts,
and many other chart types.



1 Video and Sound: You can add sound clips or video
files to your slides. You can also add background music
or a custom narration.

Starting PowerPoint

Here’s the procedure for starting PowerPoint in Windows
8, 8.1, or 10:

1. Get ready.

Light some votive candles. Take two Tylenol. Put on a
pot of coffee. If you're allergic to banana slugs, take
an allergy pill. Sit in the lotus position facing
Redmond, Washington, and recite the Windows creed
three times:

Microsoft is my friend. Resistance is futile. No beer
and no TV make Homer something something ... .

2. Press the Windows key on your keyboard.

The Windows key is the one that has the fancy
Windows flag printed on it. On most keyboards, it’s
located between the Alt and Tab keys. When you press
this button, Windows brings up the Start page, which
lists your commonly used applications in large tiles.

3. Click the PowerPoint 2016 tile.

That’s all there is to it — PowerPoint starts up in a
flash. (Note that you might have to scroll the Start
screen to the right to find the PowerPoint 2016 tile.)

If you’re using Windows 7, the procedure is a little
different:

1. Click the Start button.

The Start button is ordinarily found in the lower-left
corner of the Windows display. When you click it, the



Start menu appears. The Start menu works pretty
much the same, no matter which version of Windows
you're using.
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If you can’t find the Start button, try moving
the cursor all the way to the bottom edge of the
screen and holding it there a moment. With luck on
your side, you see the Start button appear. If not, try
moving the cursor to the other three edges of the
screen: top, left, and right. Sometimes the Start
button hides behind these edges.

. Point to All Programs on the Start menu.

After you click the Start button to reveal the Start
menu, move the cursor up to the words All Programs
and hold it there a moment. Yet another menu
appears, revealing a bevy of commands.

. Choose Microsoft Office = Microsoft Office
PowerPoint 2016.

Your computer whirs and clicks and possibly makes
other unmentionable noises while PowerPoint comes
to life.

If you use PowerPoint frequently, it might appear
in the Frequently Used Programs list directly on the
Start menu so you don’t have to choose All Programs
= Microsoft Office to get to it. If you want
PowerPoint to always appear at the top of the Start
menu, choose Start = All Programs = Microsoft
Office. Then, right-click Microsoft Office PowerPoint
2016 and choose the Pin to Start Menu command.
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@ If you hate clicking through menus but don’t mind
typing, another way to start PowerPoint is to press
your keyboard’s Windows key (usually found
between the Ctrl and Alt keys), type the word
powerpoint, and press the Enter key. (Note that this
trick works only in Windows 7.)

Navigating the PowerPoint
Interface

When you start PowerPoint, it greets you with the screen
shown in Figure 1-1. This screen lets you create a blank
presentation, open a recently used presentation, or
create a new presentation based on a template. You can
also take a video tour of PowerPoint.

PowerPoint

i Open Oty Prewratan

Figure 1-1: PowerPoint’s opening screen.



For the purposes of this chapter, click Blank Presentation
to get started with a new presentation. You will next be
greeted with a screen that’s so cluttered with stuff that
you're soon ready to consider newsprint and markers as
a viable alternative for your presentations. The center of
the screen is mercifully blank, but the top part of the
screen is chock-full of little icons and buttons and
doohickeys. What is all that stuff?

Figure 1-2 shows the basic PowerPoint screen in all its
cluttered glory. The following list points out the more
important parts of the PowerPoint screen:

File tab

Quick Access toolbar

Slides pane Ribbon

Click to add title

Click to add subtitle

Status bar Current slide Zoom control
Figure 1-2: PowerPoint’s cluttered screen.




1 Ribbon: Across the top of the screen, just below the
Microsoft PowerPoint title, is PowerPoint’s main user-
interface gadget, called the Ribbon. If you've worked
with earlier versions of PowerPoint, you were
probably expecting to see a menu followed by one or
more toolbars in this general vicinity. After meticulous
research, Microsoft gurus decided that menus and
toolbars are hard to use. So they replaced the menus
and toolbars with the Ribbon, which combines the
functions of both. The Ribbon takes some getting used
to, but after you figure it out, it actually does become
easier to use than the old menus and toolbars. The
deepest and darkest secrets of PowerPoint are hidden
on the Ribbon. Wear a helmet when exploring it.

Note that the exact appearance of the Ribbon varies a
bit depending on the size of your monitor. On smaller
monitors, PowerPoint may compress the Ribbon a bit
by using smaller buttons and arranging them
differently (for example, stacking them on top of one
another instead of placing them side by side).

For more information about working with the Ribbon,
see the section “Unraveling the Ribbon,” later in this
chapter.

1~ File tab: The first tab on the Ribbon is called the File
tab. You can click it to switch the program into a
special mode called Backstage View, which provides
access to various functions such as opening and
saving files, creating new presentations, printing, and
other similar chores. For more information, see the
section “Taking the Backstage Tour,” later in this
chapter.

1 Quick Access toolbar: Just above the Ribbon is the
Quick Access toolbar, also called the QAT for short. Its
sole purpose in life is to provide a convenient resting




place for the PowerPoint commands you use the most
often.

Initially, this toolbar contains just three: Save, Undo,
and Redo. However, you can add more buttons if you
want. To add any button to the QAT, right-click the
button and choose Add to Quick Access Toolbar. You
can also find a pull-down menu at the end of the QAT
that lists several frequently used commands. You can
use this menu to add these common commands to the
QAT.

1 Current slide: Right smack in the middle of the

screen is where your current slide appears.

1~ Slides pane: To the left of the slide is an area that

shows thumbnail icons of your slides. You can use this
area to easily navigate to other slides in your
presentation.

1 Task pane: To the right of the slide is an area called

the task pane. The task pane is designed to help you
complete common tasks quickly. When you first start
PowerPoint, the task pane isn’t visible, so you can’t
see it in Figure 1-1. However, it appears whenever it’'s
needed, and you can see plenty of examples of it
throughout this book.

1~ Status bar: At the very bottom of the screen is the

status bar, which tells you the slide that is currently
displayed (for example, Slide 1 of 1).

oF

You can configure the status bar by right-
clicking anywhere on it. This right-click reveals a list
of options that you can select or deselect to determine
which elements appear on the status bar.

1 Zoom control: PowerPoint automatically adjusts its

zoom factor so that Slide View displays each slide in its



entirety. You can change the size of your slide by using
the zoom control slider that appears at the bottom
right of the window.

of

@ You’ll never get anything done if you feel that you
have to understand every pixel of the PowerPoint
screen before you can do anything. Don’t worry
about the stuff that you don’t understand; just
concentrate on what you need to know to get the job
done and worry about the bells and whistles later.

Unraveling the Ribbon

The Ribbon is Microsoft’s primary user interface gadget.
Across the top of the Ribbon is a series of tabs. You can
click one of these tabs to reveal a set of controls specific
to that tab. For example, the Ribbon in Figure 1-2
(earlier in the chapter) shows the Home tab. Figure 1-3
shows the Ribbon with the Insert tab selected.
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Figure 1-3: The Ribbon with the Insert tab selected.

Initially, the Ribbon displays the tabs described in Table
1-1.

Table 1-1 Basic Tabs on the Ribbon

Tab Actions You Can Perform
File Open, close, print, and share presentations
Home Create and format slides

Insert Insert various types of objects on slides




Tab Actions You Can Perform

Design Tweak the layout of a slide

Change the transition effects that are applied when you switch

Transitions from one slide to the next

Animations Add animation effects to your slides

Slide Show Present your slide show

Review Proof and add comments to your presentations

View Change the view

Besides these basic tabs, additional tabs appear from
time to time. For example, if you select a picture, a
Picture Tools tab appears with commands that let you
manipulate the picture.

The commands on a Ribbon tab are organized into
groups. Within each group, most of the commands are
simple buttons that are similar to toolbar buttons in
previous versions of PowerPoint.

lelling PowerPoint What
to Do

The Ribbon contains scores of buttons that enable you to
use any of PowerPoint’s many features for creating and
formatting slides. Unfortunately, the Ribbon can
sometimes be difficult to navigate, and if you're like me,
you’ll often find yourself unsure of which Ribbon tab
contains the button you’re looking for.

That’s where the Tell Me What to Do box comes in. This
search box is located above the right side of the Ribbon.
Type what you want to do in this box and PowerPoint will
take you directly to the Ribbon button that lets you do it.
For example, if you type Open, the Open button from the



File menu appears. This feature can be a great timesaver
when you know what you want to do but you aren’t sure
exactly where in the Ribbon the correct button is
located.

The View from Here Is
Great

Near the right edge of the status bar is a series of four
View buttons. These buttons enable you to switch among
the various views, or ways of looking at your
presentation. Table 1-2 summarizes what each View
button does.

Table 1-2 View Buttons

Button What It Does

= Switches to Normal View, which shows your slide, outline, and
notes all at once. This is the default view for PowerPoint.

oo Switches to Slide Sorter View, which enables you to easily
rearrange slides and add slide transitions and other special effects.

E3 Switches to Reading View, which displays your slide show within a
window.

Switches to Slide Show View, which displays your slides in full-
= screen mode. This is the view you use when you’re actually giving
your presentation.

Taking the Backstage Tour

Every summer, I attend plays at the Oregon Shakespeare
Festival in Ashland, Oregon. A few years ago, I took the
special backstage tour, which revealed all kinds of nifty
secrets worthy of a Dan Brown novel.



This section takes a brief look at PowerPoint’s Backstage
View feature, which provides access to document
management features previously found on the File menu.
When you click the File tab in the top-left corner of the
PowerPoint window, PowerPoint switches to Backstage
View, as shown in Figure 1-4.

Open
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Figure 1-4: Backstage View.

Initially, Backstage View displays information about the
current presentation. However, the menu on the left —
which bears a striking resemblance to what used to be
called the File menu back in the day when programs had
plain menus instead of fancy ribbons — provides access
to the hidden features of PowerPoint available only to
those who venture backstage.

You find out how to use the most important of these
commands later in this chapter, and several of the more
advanced commands on this menu are presented in later
chapters.



Okay, the only secret I learned on the backstage tour at
Ashland that was really worthy of a Dan Brown novel is
the one about Psalm 46 in the King James translation of
the Bible, which was published in 1611 — when William
Shakespeare turned 46. If you count 46 words from the
start of the Psalm, you get the word Shake. And if you
count 46 words backwards from the end of the Psalm,
you get the word Spear. Which clearly means that there’s
a treasure buried directly beneath the stage in Ashland’s
outdoor theater. Next year I'm taking a shovel.

Creating a New
Presentation

The simplest way to create a new presentation is to start
PowerPoint, click Blank Presentation on the opening
screen (see Figure 1-1), and then edit the blank
presentation to your liking.

After PowerPoint is started, you can also create a new
presentation by clicking the File tab to switch to
Backstage View and then clicking the New command.
This action brings up the screen shown in Figure 1-5,
which offers several ways to create a new presentation:

1 Choose Blank Presentation: Double-click Blank
Presentation to start a new presentation from scratch.

1 Choose a template: You can select one of the
displayed templates to create a new presentation
based on the template’s design. Several templates are
displayed on the New screen.

1~ Search for a template: You can type a search phrase
into the Search text box and then click the magnifying
glass icon. Doing this opens a list of templates that



match your search criteria. Double-click one of these
templates to create a presentation based on it.
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Figure 1-5: Creating a new presentation on the New screen in Backstage View.

Editing text

In PowerPoint, slides are blank areas that you can adorn
with various objects. The most common type of object is
a text placeholder, a rectangular area that’s specially
designated for holding text. (Other types of objects
include shapes, such as circles or triangles; pictures
imported from clip art files; and graphs.)

Most slides contain two text objects: one for the slide’s
title and the other for its body text. However, you can
add more text objects if you want, and you can remove
the body text or title text object. You can even remove
both to create a slide that contains no text.

oF
@ Whenever you move the cursor over a text object,
the cursor changes from an arrow to the I-beam,



which you can use to support bridges or build
aircraft carriers. Seriously, when the cursor changes
to an I-beam, you can click the mouse button and
start typing text.

When you click a text object, a box appears around the
text, and an insertion pointer appears at the spot where
you clicked. PowerPoint then becomes like a word
processor. Any characters that you type are inserted into
the text at the insertion pointer location. You can press
Delete or Backspace to demolish text, and you can use
the arrow keys to move the insertion pointer around in
the text object. If you press Enter, a new line of text
begins within the text object.

When a text object contains no text, a placeholder
message appears in the object. For example, a title text
object displays the message Click to add title. Other
placeholders display similar messages. The placeholder
message magically vanishes when you click the object
and begin typing text.

R
@ If you start typing without clicking anywhere, the
text that you type is entered into the title text object
— assuming that the title text object doesn’t already
have text of its own. If the title object is not empty,
any text that you type (with no text object selected)
is simply ignored.
After you finish typing text, press Esc or click anywhere
outside the text object.

In Chapter 2, you find many details about playing with
text objects, but hold your horses. You have more
important things to attend to first.

Adding a new slide



